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The act of giving, whether 

through time, resources, 

or simple acts of kindness, 

holds immense power 

to not only improve the 

lives of others but also 

significantly enhance 

our own well-being. It 

can foster a sense of 
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simultaneously 

contributing to a more 

positive and supportive 
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community. This is certainly true at Ortho2.

Giving Time: In 2019, Ortho2 enacted a new volunteer time 

off policy, allowing all employees to request one paid day off 

per calendar year to volunteer at a nonprofit organization. 

Many employees have taken time to help serve meals to 

those in need or volunteer with youth in their communities. 

Giving Resources: The Ortho2 Team gives resources 

to several organizations but most notably, the United 

Way, which focuses on “leading the fight for the health, 

education, and financial stability for every person.” The 

United Way reimagines what’s next for individuals, families, 

human services, and communities – all with a vision of 

improved quality of life for everyone.

For more than 25 years, Ortho2 has partnered with 

the United Way’s annual giving campaign. And Ortho2 

employees have really stepped up to help those in our 

community. Throughout the last decade, the Ortho2 Team 

has donated more than $134,000 to the United Way to 

further this mission. Additionally, Ortho2 partners with the 

annual United Way Food Drive, donating the most dollars 

in Story County earlier this year. Through this donation, the 

United Way is able to provide nearly 8,000 pounds of food 

to those in need.

Another organization Ortho2 has partnered with is the 

American Association of Orthodontists Foundation (AAOF). 

Since 1992, Ortho2 has pledged and donated more than 

$25,000 to advancing the specialty of orthodontics.

Simple Acts of Kindness: Whether it’s a friendly good 

morning to a coworker or going above and beyond for 

a customer request, the Ortho2 Team strives to embody 

kindness in all things. I see and hear these things throughout 

our organization every day and hope you have personally 

experienced them too. We frequently receive Extra Mile 

submissions for Ortho2 team members who have provided 

exceptional service. A couple recent examples include:

“Exceptional service provided to our office for more than 

30 years! We appreciate all of the many helpers who help 

with great efficiency and excellent customer service!”

“I am very grateful for the Implementation Team’s 

expertise, professionalism, and willingness to assist me 

every step of the way. Their commitment to excellence 

and customer service does not go unnoticed, and I feel 

very fortunate to have had the opportunity to learn Edge 

Cloud. Exceptional support, and unwavering dedication 

to helping me navigate the Ortho2 Edge Cloud program 

consistently exceeds expectations. Thank you again!”

These messages are shared company-wide through our 

online Kudos board, a platform that also allows us to 

acknowledge each other for a job well done. If you’d like 

to share how an Ortho2 team member has gone the extra 

mile for you, check out page 11 to see how you can submit 

a form.

Giving comes in many forms. In a world that can often focus 

on the negative, giving can not only help others but also 

benefit you. I hope you will consider giving your time, your 

resources, and/or simple acts of kindness in 2025.  
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Amy Schmidt, Ortho2 President

Amy Schmidt

ortho2 users 
group meeting

feb 27-
mar 1
2025

austin, tx

®

thank you to our silver sponsors

thank you to  
our gold sponsor

Get ready for an unforgettable experience! Our Users 
Group Meeting is your chance to connect, learn, and 
share ideas with fellow users and industry experts. It’s 
the perfect place for fresh insights and networking 
opportunities. You don’t want to miss out – the next time 
you can experience our in-person meeting is in 2027.

the event of the year

There’s still time to secure your spot, so 
register today! We can’t wait to see you 
in Austin!
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E very time you open a report, a mail merge document, 

or check on your 

scheduled reminders, you see it 

in the corner – subgroups. You 

may have used these for pulling 

a list of your past due patients 

in your statement reports, or 

even have one on your 

dashboard. They are handy and 

seemingly everywhere!

These subgroups are great, but what do they actually do? 

Let’s start by imagining your data as a big pool of manila 

folders; patients, professionals, and all kinds of records. 

Maybe you want to find all of your patients in a particular 

status, or the responsible parties with balances greater 

than a certain amount. You can pick a folder at random, 

(metaphorically grab a big armful of them) counting the 

totals as you go, and hoping your mental arithmetic is up to 

par. You will quickly find this process without any other tools 

makes what you have a rather unusable pile of data.

This is where subgroups come into play. A subgroup is 

similar to a specialized funnel, taking the large troves of data 

your practice has collected and filtering it to just what you 

need with simple logic. While there is much more subgroups 

can do, this article’s purpose is to show that depending 

on where you use them, subgroups can help you retrieve 

focused reports or target (or even avoid targeting) patients 

for reminders.

Your Subgroups
Subgroups in your database are all stored in Home > Editors 

> Subgroups. 

The folders listed in italics come with your database and are 

universal to all Edge 

Cloud users. 

Everything else listed 

is specific to your 

database. You can 

always add a new 

folder, or add a new 

subgroup to any 

existing folder. One 

example of a 

commonly used 

subgroup in the 

Appointment folder is 

the Today’s 

Appointments subgroup which is used to pick only today’s 

appointments.

If you click on the subgroup, you get to look at its details 

which helps explain the behavior of the subgroup, and 

fortunately for humans like you and me, it reads like a book! 

The first line is the appointment status. You do not want 

just any appointment today, you only want the ones that 

are made. This will filter out canceled, deleted, missed, 

etc.. The second line has a smart value (such as 11/11/2024 

or Missed or Active) but which ones you use depends 

on other factors. In this case, it is for the appointment 

date. Therefore this one is appropriately set to the smart 

value of Today. The last line is another filter; there are 

two kinds of made appointments in Edge Cloud – regular 

scheduler appointments and recalls. If we only want regular 

appointments, Appointment Is Recall needs to be set to No.

Joe Randazzo is an Ortho2 Advanced Support Tech and international 
Software Trainer with a background in Software Engineering and 
a healthy-ish obsession with technology. While hands are off the 
keyboard, he frequents karaoke venues, yaps about his electric 
compact car, and performs culinary crimes currently featuring  
Sichuan peppercorns.

Joe Randazzo 

Contact Info: ortho2support@ortho2.com • 800.346.4504

Subgroups for Reports and Reminders

And there you have it, a subgroup! There is one more 

feature to mention – namely at the top in the editor there 

are buttons labeled 

Import and Export. 

Export will let you create 

a file on your computer 

that you can later import 

into other databases – 

very handy if you are a 

consultant or otherwise manage multiple databases, the 

work you did in one subgroup editor can be transferred to 

another!

Reporting – Find Certain Types of…
Subgroups are invaluable in taking existing reports and 

making them concise. Let’s say you have a busy week and 

you want to address patients coming in who are significantly 

delinquent, say 90 days or more. While you can use your 

Scheduled Appointments report and click each patient to 

check their days past due, you can save a lot of time by 

leveraging subgroups instead.

Back in the Subgroup Editors, create a new subgroup that 

looks similar to an existing one. Pro tip – if you select a 

subgroup and right-click it, you can copy it. Then paste it 

into a folder to make an exact duplicate to modify without 

changing the original one. This is great for experimenting!

If you add the above details to a subgroup (including a 

check that avoids the patient’s insurance dues), you now 

have a subgroup that can be used on your Scheduled 

Appointments report that will only show those patients 

coming in for their appointment who are delinquent. Feel 

free to mix and match report settings and subgroup details 

to get the right amount of control over your reporting.

For another example: what if you are looking at your 

accounts receivable, but only want to target patients in a 

particular status, like Retention, to determine who may have 

just debonded while still owing. You can use a prompt field 

for flexibility. Prompt allows you to choose the setting when 

you use the subgroup in a report, which is particularly useful 

if the item you are filtering may change in the near future.

Simple as that, 

you now have a 

report for just your 

Retention patients. 

And you can use this 

subgroup again for 

other statuses on 

other reports, like 

Subgroups continued on page 10
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Founded by TWO sisters, Megan 
and Brittani Wyrick, The Wyrick 
Outlook is an orthodontic 
coaching agency specializing in 
remote orthodontic financials 
and insurance, digital courses, 
and private coaching. This 
dynamic has helped hundreds 
of practices achieve and sustain 
financial success across the 
orthodontic industry.

Megan Wyrick and 
Brittani Wyrick

Contact Info: 

info@thewyrickoutlook.com 
thewyrickoutlook.com

5 Ways to Simplify Your Practice’s 
Insurance Protocols for the New Year

Andrea Cook is a clinical 
consultant and trainer for 
premier orthodontic offices 
across the country with more 
than 20 years experience 
chairside. She offers a variety of 
services to train your staff and 
improve your practice.

Andrea Cook

Contact Info: 

andreal.cook@comcast.net 
andreacookconsulting.com

How to Avoid Employee Overload

A s a new year begins, it’s an 

ideal time to evaluate and 

refresh your practice’s systems 

and protocols to ensure they’re 

running smoothly. While many 

practices focus on updating 

operational or clinical processes, 

financial systems—particularly 

insurance protocols—often go 

overlooked. Yet, in an ever-

evolving insurance landscape, 

outdated procedures can put a 

practice at a disadvantage. Here 

are five practical ways to update 

and simplify your practice’s 

insurance protocols for the new 

year.

1. Regularly 

Review In-Network 

Participation
Evaluating your in-network 

participation annually can 

make a significant difference to 

your practice’s bottom line. As 

costs of supplies and overhead 

increase, some in-network 

contracted rates may no longer 

be sustainable. Conduct an in-

network analysis at the start of 

each year to assess the amount 

that has been written off from 

the prior year per insurance 

company. This will help your 

practice determine if current 

contracts are still financially 

beneficial. Making necessary 

adjustments can help ensure that 

in-network participation aligns 

with the practice’s financial goals.

2. Simplify With 

Bundled Billing
Orthodontic practices have an 

advantage when it comes to 

billing due to the limited number 

of CDT codes that can be used 

for orthodontic services. Most 

insurance carriers consider these 

codes to be “all-inclusive,” 

encompassing all treatment 

appliances and retainers in just 

seven main codes. By sticking to 

this bundled billing approach, 

financial coordinators can avoid 

the complexities of billing for 

each type of appliance, which 

streamlines the process and 

minimizes potential billing errors.

3. Avoid Upcharges 

on Select Services
For practices that consider 

adding upcharges for specific 

treatments, like aligners or clear 

brackets, it’s essential to evaluate 

whether these upcharges are 

truly necessary. Many insurance 

carriers do not permit these 

additional fees for in-network 

providers, and attempting to 

include them can complicate 

billing and claims processing. 

If a regular upcharge seems 

warranted for most treatments, 

consider whether the practice 

Insurance Protocols  
continued on page 11

W elcome to the New Year. One of the struggles for offices 

during the past year was staffing issues including hiring, 

training, and retention. Employee overload can be a big contributor to 

staffing issues. 

What do you do when an employee isn’t performing like they used to?

All sorts of causes could be to blame. The workload they have been 

assigned can be one of the causes of lower performance levels. 

Employee overload is a growing concern among our offices, especially 

for managers who care about their team members’ overall well-being 

— not just their job performance.

What is employee overload? Employee overload is when team 

members in an office have more work assigned than can be 

accomplished during their workday. Technology can be one of the 

contributors if the team does not have proper training and designated 

time to manage it. An early burst in productivity soon gives way to 

stress, declining performance, burnout, and even physical and mental 

health concerns. Before long, staffing and retention can begin to 

suffer.

Red Flags of Employee Overload
Employee overload doesn’t look the same in every employee. If 

you’re concerned that some of your employees may be dealing with 

overload, look for these red flags.

1.	 Decreased Levels of Productivity and Task Completion. 

Overloaded employees will quickly become overwhelmed juggling 

too many tasks, diminishing productivity and task completion. 

Productivity drops because of the time lost by switching between 

tasks, or constantly checking what’s most actively on fire at the 

moment.

And task completion also suffers, team members switch to the 

on-fire task before finishing their current one, and who knows 

when (or if) they’ll find time (or remember) to switch back to the 

unfinished task.

2.	 Decreased Work Quality. With a growing backlog of tasks to 

complete, an overloaded employee may feel significant time 

Employee Overload continued on page 12
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Carol Eaton has devoted 50 years to the field of dentistry; primarily 
in the orthodontic environment as a well-recognized consultant, 
leader, and speaker. Together with Alena Pacheco, the duo focuses on 
empowering women to pursue their dreams and enhance their work 
environment and personal development.

Carol Eaton

Contact Info: caroleatonconsulting@gmail.com

Mentoring Makes a Difference:  
Empowering Women in Work and Life

A fter 50 years in the dental/orthodontic industry, I have 

realized the valuable impact on our work and personal 

lives when engaging in the relationship of mentoring (or 

mentorship). 

By definition, “Mentorship is a relationship where a more 

experienced or knowledgeable person, called a mentor, 

helps a less experienced person, called a mentee, grow 

professionally and personally.” 

My path from registered dental assistant, treatment 

coordinator, and marketing specialist to a full-time 

orthodontic management consultant and international 

speaker was based on a great mentor in my professional 

life, Karen Moawad of Hummingbird Associates.

I was fortunate enough 

to attend some weekend 

seminars facilitated by Karen, 

and on one such occasion 

sat next to her at dinner. We 

discussed my career to date: 

ten years as a registered 

dental assistant (four in 

general dentistry and six in 

orthodontics) and my desire 

to accomplish more. At that 

time, I thought of going back 

to school to get my degree in psychology so I could work as 

a counselor for junior high and high school students. Karen 

suggested I mail her a resume before I left the dental field.

Karen was generous in her willingness to share her world 

of expertise and management systems as she guided 

me through the process of gaining more wisdom and 

experience that I could then share with orthodontic 

practices and dental audiences. As a mentor, Karen saw 

something in me that I did not see in myself at that time. 

She gave me the wings to fly along with the freedom 

to create a treatment coordinator training program, a 

marketing program and offer team building seminars.

Fast forward ten years later, almost 30 years ago, I had the 

opportunity to mentor Alena Pacheco, when she entered 

my life as a part-time assistant in my consulting business. At 

the time, Alena was attending our local university and had 

no experience in the dental field, yet she was organized, 

dependable, and willing to take on a new challenge. We 

came from vastly different backgrounds and ages yet 

bonded over braces (pun intended of course).

Our orthodontic journey brought us together and for 

the next several decades we learned from and mentored 

each other through a myriad of challenges that face 

women in the workplace. Not only did Alena assist me 

with my growing consulting business, but she also trained 

and applied for 

a TC position 

with one of my 

former employees 

and became 

an invaluable 

colleague in the 

world of logo 

design along with 

custom promotional 

and print materials.

Alena has 

acknowledged that her “20-something” view of me back 

then might have been a little skewed by her young age and 

inexperience. After all, I was only in my 40s at the time! 

Now that we are both well “seasoned,” we have had the 

opportunity to look back on our decades-long relationship 

to see how amazing it was. And, more importantly, we 

are exploring how we could have shown up differently 

to support each other at the time. I was a single mom 

raising a teenage daughter as she completed college, 

married, and started a family of three. Later, when her adult 

children were grown and exploring life on their own, I was 

now remarried and a grandmother of two. Our lives and 

individual challenges throughout those years were always 

at different stages yet our shared experiences nurtured and 

guided each other along the way.

 Transformations in Mentorship

In today’s rapidly evolving work environment, the dynamics 

of mentorship are undergoing significant changes. The 

increasing diversity in the workforce, characterized by 

multiple generations working side by side – from Baby 

Boomers to Generation Z – presents both challenges and 

opportunities. Multi-generational mentorship harnesses 

the unique strengths and perspectives of each generation, 

fostering an inclusive culture that enhances employee 

engagement, productivity, and knowledge transfer.

Benefits of Mentorship:

1.	 Develop Confidence

2.	 Learn New Skills

3.	 Navigate Challenges

4.	 Feel More Secure in Asking for Advice

5.	 Build a Strong Identity

6.	 Learn to Take Action

7.	 Improve Diversity, Equity, and Inclusion

8.	 Nurture Talent

9.	 Enhance Employee Satisfaction

As a mentor encourages a mentee, they help with problem-

solving by using active listening techniques. A mentor 

becomes a “guidance counselor” as they help guide the 

mentee’s behavior, values, and attitudes; sharing values 

and deep-level similarities. A mentor can help a mentee 

reach their goals (professionally and personally) as they raise 

awareness, confidence, and leadership skills.

Now, before you get worried that you must have it all 

together in your own life before you can help someone else, 

let me reassure you that you don’t! Most of us are facing 

challenges in our lives, no matter our age or circumstances. 

Most of us are dealing with difficulties. When we surround 

ourselves with other people who genuinely care about 

showing up and supporting us, we can deal with those 

problems together and leverage the life experience that 

we each bring to the table. Let’s be honest, age doesn’t 

give us fewer problems. It does, however, give us a depth 

of experience that we can share with others when they are 

going through similar circumstances.

Can you list people in your life who have been your 

professional or personal mentors? Have you taken the time 

to thank them and tell them what they have helped you 

accomplish? Are you currently mentoring someone as you 

share your skills and life experiences with them?

Alena and I were fortunate that the universe brought us into 

each other’s lives almost 30 years ago. Neither of us had it 

all together then, and, in fact, we’re still a work in progress 

now. That’s the beauty of having authentic mentoring 

relationships. None of us are perfect and we don’t need to 

be. We do, however, need to cultivate a framework and daily 

practice that creates a supportive mentoring environment 

in our work and in our lives. And we know how challenging 

that can be in an orthodontic office. 

Mentoring continued on page 14

Multi-generational mentorship 
harnesses the unique strengths and 
perspectives of each generation, 
fostering an inclusive culture that 
enhances employee engagement, 
productivity, and knowledge transfer.
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Subgroups continued from page 5 Insurance Protocols continued from page 6

We invite you to recognize Ortho2 employees by submitting 
an Extra Mile form. The form is available online from the 
Contact Us page of our website. Our goal is to uphold our 
tradition of excellence in customer service, and with our Extra 
Mile program, you can let our employees know when you 
appreciate their extra effort. We encourage you to submit an 
Extra Mile form whenever an Ortho2 employee goes the extra 
mile for you. The recognition is valued by the recipient and 
is acknowledged by our management team. We continue to 
look for better ways to serve you. Thank you for helping us 
recognize excellence.

Service Excellence

Observations in the Patient List report, or Clear Aligners on 

your Exceeds Length of Treatment report. The possibilities 

are really only limited by the list of subgroup details and 

your imagination!

Reminders – Target Who You Want
Have you heard about our visual tag system? Visual tags 

allow you to tag patients and responsible parties with 

colorful symbols to, at a glance, share information internally. 

This could be as innocuous as a little green dollar sign 

symbol for patients with financial troubles, yellow stars for 

patients who are awesome with compliance, or red squares 

for those patients or responsible parties that just need a 

little extra TLC.

Did you know you can use visual tags in subgroups, 

including ones for Reminders? If you add a visual tag or 

other criteria to the subgroup being used for a Scheduled 

Reminder, it can exclude individuals with that visual tag 

from that message set, without removing them out from the 

entire Reminder system.

Subgroups - Food for Thought
As a bonus for sticking with me thus far, here are two more 

subgroup examples and what they do. The first is a relatively 

simple example of a tweak for missed appointments. By 

adding the Has Appointment = No detail, if the patient 

reschedules – no harm no foul! They will not be notified of 

their missed appointment because they rescheduled, saving 

a superfluous message about them missing the appointment 

and rescheduling again when they already have. Note: 

this is only recommended if you normally schedule one 

appointment in advance at a time. 

The second example is casting a wide net for happy 

birthday reminders – this will include your active statuses, 

patients with appointments, and patients who recently 

had appointments – so nobody is truly missed out on their 

special day! 

Subgroup pros take note: this particular subgroup uses OR 

and parentheses to help organize the logic. Another way of 

reading it would be, “Patients whose birthdays are today, 

and who have either had an appointment within the last sixty 

days or require a new appointment.” If that is not everybody 

who deserves a happy birthday message to your practice 

without overrun, let us know!

In summary, there is quite a lot you can do with subgroups, 

and we have only begun to scratch the surface here. If you 

have ideas for more subgroup details, please let us know at 

ortho2support@ortho2.com - we look forward to your ideas! 

As a friendly reminder, if you need any help setting these up 

or if you get stuck during this process, our stellar Software 

Support Team is available on demand to remote in and help 

at 800-346-4504.  

truly benefits from being an in-network 

provider. Oftentimes, the insurance 

benefit remains the same for in vs. out-

of-network providers, which may make 

out-of-network participation a more 

straightforward and profitable choice.

Note: New in 2025, the CDT has 

introduced the D8091 code specifically 

for surgical cases. This would 

replace the previous D8090 code for 

surgical cases and may offer a higher 

contracted rate, thus eliminating the 

need to upcharge for surgical cases.

4. Stick to Paper Checks 

for Payments
As more insurance carriers push for 

practices to accept EFT payments 

or virtual credit cards, managing 

these forms of payment can become 

cumbersome. EFT reconciliation 

requires financial coordinators to 

track and reconcile direct deposits 

into the practice’s bank account. This 

can be tricky when the majority of 

doctors aren’t comfortable providing 

their financial coordinator with that 

information.

On the other hand, virtual credit card 

payments incur additional merchant 

fees, increasing costs for the practice. 

Sticking with paper checks is a simple 

and cost-effective alternative, making 

reconciliation easier for financial 

coordinators without adding extra fees.

5. Set Clear Timing 

for Insurance Claim 

Submission
Many practices activate insurance 

contracts as soon as a financial 

agreement with the patient is signed. 

This date may differ from the date 

that the appliances are delivered, 

which is the date required on the 

insurance claim. While entering a 

contract at financial commitment may 

look good as a conversion statistic, it 

can create billing challenges if there 

isn’t a clear process for notifying the 

financial coordinator of the appliance 

delivery date. Delayed submissions can 

result in timely filing denials, creating 

extra work and potential revenue 

loss. Establish a protocol for when 

insurance claims should be submitted 

to prevent these issues and make the 

billing process more straightforward for 

coordinators.

In summary, simplifying your practice’s 

insurance protocols can have a 

substantial impact on efficiency, 

accuracy, and overall financial health. 

By regularly evaluating in-network 

participation, adopting bundled billing, 

avoiding unnecessary upcharges, 

choosing straightforward payment 

methods, and establishing clear timing 

for claim submissions, your practice 

can reduce administrative burdens and 

improve cash flow. These proactive 

steps help ensure your practice is well-

prepared for the new year, leaving 

more time to focus on patient care and 

practice growth. 

Looking for EDGEucational content to help you become an Edge Cloud guru? Our brand new 
EDGEpisodes series is perfect for you! These bite-size videos will provide you with quick and 
easy tips to master all things Edge Cloud and are easily accessible on Facebook and Instagram.

EDGEucate Yourself With EDGEpisodes
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Employee Overload continued from page 7

Congratulations to Ben Lievens on becoming a certified Henry Schein Culture 
Ambassador! Ben is an Implementation Expert and has been with Ortho2 for 
almost a year. As a Culture Ambassador, Ben will promote and encourage 
Henry Schein’s DEI values within the organization and its subsidiaries, market 
offerings and opportunities for resources that are sent out by Henry Schein, 
and mentor new hires. We’re so proud of this accomplishment!

Career Development

There are many resources available to you on our website. You will find visual help videos, printed documentation, 
request forms, information on upcoming meetings, and more.

If you haven’t already created an account to access the Customer Site of our website, you will need to do that. Each 
doctor and team member can create their own account. Visit support.ortho2.com, and click Register New User 
under the Login fields.

You will be prompted for your full name, main office phone number, and Ortho2 customer number. Finally, enter 
your individual email address, a password of your choice (at least five characters), and a display name that will be 
publicly visible. 

Log Into support.ortho2.com

Do you need to call in to our Support Team for a question, but it’s difficult to wait on hold, 
even for a few minutes? Ortho2 has you covered! Use our chat support to get in contact 
with us. When you use the chat support feature, you will be added to the same queue as 
phone calls. You can choose to chat with the Software Support, Implementation, or Network 
Engineering Teams. 

In Edge Cloud, you can find links to chat support through the Help menu. In ViewPoint, click 
the Help button in the bottom right of the Daily Activities menu.

Chat Supportpressure. When people constantly feel under the gun, 

they tend to cut corners, skip final checks, and move 

just a little faster than they should. This may lead to 

digital workflow not getting submitted or an increase in 

emergency visits.

3.	 Decreased Energy and Motivation Toward Work. If 

you notice once happy and motivated team members 

starting to look lethargic and disengaged, you’ll 

certainly want to investigate. Numerous causes could 

contribute, including office culture, mental health, and 

overload or overwork.

4.	 Increased Distractedness. The more overworked 

a team member feels the worse things get in terms 

of energy levels. Before long, focusing on anything 

becomes difficult, which can manifest as a constant 

stream of distractions, inattention during appointments, 

etc.

Given the red flags and symptoms I described above, most 

doctors and managers seek to avoid overloading their 

team members. But how can doctors/managers do this 

consistently in a world where they’re being asked to do 

more with less?

These five tips are a great place to start assessing and 

balancing workload, reducing overload, overwhelm, and 

overwork for your team members.

1.	 Create a Time Budget. A time budget sets aside blocks 

of time for the highest priority work. A time budget only 

works if you have certain capabilities in place, though. 

You still have to have a way to forecast how long various 

tasks will take. You also need a way to track and quickly 

view tasks that have been assigned to your team 

members.

But once you get those capabilities in place, budgeting 

your team members’ time (and your own) is a great way 

to take control of schedules and timelines, rather than 

letting them control you.

2.	 Set Clear Goals and Milestones. In most offices, 

there will be inevitable, unavoidable short bursts of 

intensity from time to time. This is especially common 

in orthodontics where big pushes for production 

are frequent. Great managers encourage their team 

members to push themselves through a particularly 

tough period and relax during our slower periods.

The trouble comes when this kind of intensity seems 

to last forever, with no clear goal or milestone to work 

toward. Prevent overload from becoming the norm by 

setting up clear goals and milestones — and planning 

for periods of lower intensity once teams reach them.

Celebrating when milestones are reached is very 

reenergizing for the team. Continually focusing on 

future goals can be an exhausting treadmill effect 

if we don’t look back, recognize, and celebrate the 

accomplishments we have made.

3.	 Delegate Tasks to the Appropriate Team Members. 

On some teams, overload isn’t immediately obvious. 

Certain members of the team might even have 

noticeable downtime. If some team members are 

relatively bored while others are badly overloaded, 

the problem is workload balancing — or a failure to 

delegate properly.

Sometimes rethinking work assignments can help, too. 

You may encounter an overloaded employee who is 

simply not very good at the primary assigned task but 

would succeed or even thrive with different work.

4.	 Review Tasks to Determine if They Need to be Done. 

Some tasks can be put on hold until staffing increases 

and stress decreases. Move tasks into different buckets 

to address need and time from team members. These 

buckets might be:

Keep Doing – there are certain tasks that must be 

maintained such as spore tests, managing digital 

workflow, etc.

Stop Doing – as you evaluate tasks it may ease the 

workload if some are discontinued. If your emergency 

rate is at an acceptable level, this tracking may be on 

hold. These can be restarted as needed.

Start Doing – prioritizing data that is impacting the 

office may be a reason to implement tasks. If your 

patients over ECD is very high, it may be beneficial to 

implement a system to reduce the number. This will 

ease the schedule and patient flow as well as increase 

your financial picture.

5.	 Utilize Technology. The world of productivity tools 

and project management software has evolved to a 

staggering degree in the past few years. Offices using 

the latest technology, software, and platforms can 

produce more and stay better organized, but this can 

be overwhelming for teams if not managed.

If you’re still managing projects in spreadsheets or 

manually tracking who’s doing what, it may be time 

to look at options that may make the jobs easier to 

manage. The are some great options for outsourcing 

certain tasks in your office, from virtual assistants to 

remote tracking. Utilizing these may help with reducing 

overload issues before they turn into burnout and 

retention issues.

Offices and teams are under a high level of stress and 

burnout now. With the new year beginning, getting a handle 

on the level may help offices and team members move 

through the coming year more easily. 

Employee Overload continued from previous page

Employee Overload continued on next page
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Have you noticed the customer alerts on our website? Probably not, as they aren’t there that often. But 
if there ever is an issue with one of our products, you will see an alert letting you know what is going on. 
Once things have been resolved, the alert will go away. You won’t see these often, but they are a good 
source of information when things do arise. 

Customer Alert

Thirty-Two Years
Todd Schuelka

Thirty Years
Michele Eich

Twenty-Six Years
Lowell Davis 

Denise Sargent 

Jennifer Shaffer

Twenty Years
Corey Schmidt

Nineteen Years
Derek Dohrman

Twelve Years
Drew Humphrey

Eleven Years
Steve Volcko

Three Years
Zach Benjamin

Two Years
Alex Richardson

One Year
Ashley Hurt 

Ana Lopez 

Dexter Pierre-Louis

Celebrating Ortho2 Anniversaries

Congratulations to these Ortho2 team members who celebrated anniversaries during the fourth quarter of 2024

Referrals continued on next page

You can earn a $500 credit for each referral that results in an Ortho2 system purchase 
within six months. You can apply the credit toward any current or future charge or 
purchase — it never expires. We frequently hear from doctors that they wish we had 
contacted them before they purchased their current system. We wish we had too, but 
we didn’t know they were looking. You can help us help your colleagues by letting us 
know when they are considering a change in systems. Enter referrals by using the QR 
code to the left. 

Referral Rewards

Retraining

Have you hired new team members since your original software training? 
Have you had team members take on new responsibilities? Do you feel you 
might not be taking advantage of the enhancements that have been added 
over the years?

Ortho2 offers many options for refreshing your knowledge of old features 
and informing you of new features, but do you want to be able to set your 
own agenda to meet the specific needs of your practice?

A retraining — either in your office or over the Internet — addresses all 
these issues. To learn more and to schedule one for your practice, contact 
your Ortho2 Regional Manager today at 800.678.4644 or sales@ortho2.com.

Please be prepared to provide your customer number, practice name, and office location when you call our 
support teams for assistance. You can find your customer number in Edge Cloud by clicking File > About. If you 
use ViewPoint, you will find your customer number by clicking the Help menu and choosing About. Please be sure 
to provide this information—and repeat your phone number—when leaving a phone message requesting support. 

Help Us Help You

By Phone: 800.346.4504

By Email: ortho2support@ortho2.com

And Don’t Forget Our Website:  
support.ortho2.com

Available 7:00 A.M. – 7:00 P.M. Central Time, Monday – Friday 

Response time is usually the same day or at most within 24 hours.

Our website gives you 24/7 access to our knowledge base, FAQs,  
white papers, visual help videos, and more.

Contact Support

There’s a great quote by Arthur Ashe that says, “Start where 

you are. Use what you have. Do what you can.” What better 

place to start than in the orthodontic offices where you work 

every day? What better gift to give than the unique lived 

experience that you have to share? And what better thing 

to do than to inspire transformational change? Let’s start 

together and let’s start today! 

New Adventures
Alena and I are collaborating once again in our new 

adventure of empowering women of all ages and stages of 

their lives. Our passion is not only focused on mentorship, 

but also women in orthodontics. We look for ways that 

women can help each other grow in the workplace and, 

more importantly, in life. Our goals are to help women: 

•	 Redefine or reframe success 

•	 Identify and harness core values 

•	 Recognize perfectionism and hustling for worthiness

•	 Create genuine mentorship relationships in work and in 

life

Stop by our booth at the 2025 Ortho2 Users Group Meeting 

to see what we are cooking up and what our favorite 

ingredients are for the spices of life! 

Mentoring continued from page 9
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